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1 Pålogging med TI-kontoen din

Pålogging med TI-kontoen din
Du må logge på TI-kontoen din for å kunne bruke TI-SmartView™
emulatorprogramvaren for MathPrint™-kalkulatorer.

1. Start TI-SmartView™ emulatorprogramvaren for MathPrint™-kalkulatorer.

Hvis dette er første gangen programvaren startes, blir du bedt om å akseptere
lisenser, personvern og vilkår for bruk på nettet.

Klikk på Accept.

2. I påloggingsforespørselen, klikk på LAUNCH SIGN IN.

Merk: Hvis du må kjøpe en enkeltbrukerlisens, klikk på PURCHASE LICENSE.

Dette vil åpne påloggingssiden til Texas Instruments i nettleseren din. Fullfør
påloggingsprosessen med en Google-konto eller med den e-postadressen som er
assosiert med TI-kontoen din.



Når du har validert kontoen din, vises en vellykket-melding i nettleseren, og
programvaren åpnes.

Vise lisensinformasjon

Mens du er innlogget, kan du vise detaljene i lisensen.

▶ Gå til Help > License Info.

Kontoinformasjon: Den aktuelle brukerens e-postadresse.

Abonnementet utløper: Utløpsdato for den aktuelle programvarelisensen.

Økt utløper: Tid igjen i den aktuelle økten.

Mens programvaren er i bruk, kobler den seg til lisenssystemet hvert 15. minutt.
Hvis brukeren kobler seg av fra nettet, vil programvaren kjøre i sju døgn fra siste
gang den var tilkoblet.

Avlogging fra kontoen din

1. Gå til Help > Sign Out.

2. Klikk på SIGN OUT.

Programvaren lukkes og en nettleserflik åpner påloggingssiden.

Når du logger deg av, lagres den aktuelle tilstanden og lisensen sendes tilbake til
rekken av tilgjengelige plasser. Hvis du avslutter ved å bruke File > Exit eller ved å
bruke lukkeknappen , vil ikke automatisk logge deg av og avslutte bruk av
lisensen.
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3 Introduksjon tilTI-SmartView™ Emulatorprogramvare tilMathPrint™ Kalkulatorer

Introduksjon tilTI-SmartView™ Emulatorprogramvare
tilMathPrint™ Kalkulatorer
TI-SmartView™ emulatorprogramvare tilMathPrint™ kalkulatorer gir deg mulighet for å
vise en TI-vitenskapelig kalkulator for hele klasserommet.

Kalkulator emulator arbeidsområde

Lar deg:

• Velge Emulator
– Velge en emulator å jobbe med.

– TI-30X Plus MathPrint™
– TI-30X Pro MathPrint™
– TI-30X Prio MathPrint™
– TI-30XB MultiView™
– TI-30XS MultiView™
– TI-34 MultiView™

• Skjule/Vise stor emulatorskjerm
– Vise full emulatorvisning med eller uten et storskjermpanel.

• Skjule/Vise tastetrykklogg
– Viser bilder av taster som er trykket, slik at studentene kan følge

med disse tastene.
• Start et separat skjermdump-vindu

– Klippe ut og lagre emulatorskjermer som datafiler som TI Connect™
CE skjermutklipp.

Se: Bruk Calculator Emulator Workspace til forbedring av presentasjoner i
klasserommet.

Velg din Emulator type
Første gangen TI-Smartview™ til MathPrint™ brukes på datamaskinen din, vil det vises
dialogboksmelding.



Velg emulatortype ved hjelp av
rullegardinmenyen og velg OK.
Den valgte emulator vil vises ved din første
presentasjon.

TI-SmartView™ til MathPrint™vil alltid åpne samme sted som du sluttet sist i
programvaren. Når du er inne i programvaren, kan du endre standardemulatoren.

Se:Velge en emulatortype

Den siste emulatortypen vil vises som en standardinnstilling, og den siste
vindustørrelsen vil også vises i henhold til de siste innstillingene du gjorde.

Se:Endre størrelsen på TI-SmartView™ -Kalkulatorens emulatorskjerm

Kalkulatorens emulatorskjerm
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5 Introduksjon tilTI-SmartView™ Emulatorprogramvare tilMathPrint™ Kalkulatorer

Merk: Bildene i denne veiledningen kan være forskjellige avhengig av hvilken emulator
du har valgt.



Bruke TI-SmartView™ Emulator Workspace
tilMathPrint™ Kalkulatorer
TI-Smartview ™ emulator workspace til MathPrint ™ Kalkulator inneholder verktøy du
kan bruke til å legge inn beregninger.
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7 Bruke TI-SmartView™ Emulator Workspace tilMathPrint™ Kalkulatorer

Deler av TI-Smartview™ Emulator Workspace

Menylinje - bruk disse menyene til å utføre emulatorfunksjoner, inkludert:

• File (Lagre) – for å avslutte • Actions (Handlinger) - f.eks. skjermdump
• Edit (Rediger) - inkluder

kopitast som tekst • Help (Hjelp) - hjelp og lenker

• View (Visning) - endre
visningene

Merk: Du kan fullføre de fleste av handlingene i disse menyene ved å klikke på
ikonene i verktøylinjen.

Verktøylinje- bruk disse verktøylinjeikonene til å
• Velge en annen kalkulatormodell
• Skifte displayer av storskjerm, skjule eller vise og for å slå på og av

tastetrykkloggen
• Avfotografere aktuell emulatorskjerm

Velg posisjonene til emulatoren og verktøylinjen

• Emulatorens posisjon - venstre/høyre - for å bytte mellom venstre
og høyre visning av den grafiske kalkulatorens skjermbilde. Dette er bekvemt
ved projisering av en interaktiv tavle.

• Verktøylinje topp/bunn - for å bytte verktøylinjene mellom toppen
og bunnen av skjermen. Dette er bekvemt ved projisering av en interaktiv
tavle.

Merk: Du kan endre den visuelle utformingen og/eller plasseringen av elementer
for å optimalisere tilgang, spesielt når du bruker en interaktiv tavle.

Emulatorpanel – Bruk dette panelet for å vise hele emulatoren eller kun visning
av emulatortastaturet.

Stor visningsskjerm-panel / Tastetrykklogg-panel - bruk dette panelet for å vise en
større versjon av kalkulatorskjermen og/eller for å vise tastetrykkloggen.
Du har følgende visningsalternativer tilgjengelig:

• Kun stor visningsskjerm • Kun tastetrykklogg
• Stor visningsskjerm +

Tastetrykklogg • Skjule storskjermen

Endre panelstørrelsen - klikk og dra den vertikale linjen på siden av et panel for å
endre størrelsen.



Bruke TI-SmartView™ Emulator-tastaturet
Musen trykker på tastaturet i stedet for fingrene på datatastaturet.

Klikk på tastene på TI-Smartview™ for MathPrint™ emulator som du ville ha trykket på
tastene på den vitenskapelige kalkulatoren.

Du kan holde nede en piltast for å rulle markøren kontinuerlig.

Når du bruker en piltast for å bevege markøren, kan du holde inne tasten for å rulle
markøren kontinuerlig, så slipper du å trykke gjentatte ganger på tasten. I
tastetrykkloggen har ikonet for gjenta-piltasten et klokkesymbol knyttet til seg.

Hvis du trykker på en piltast flere ganger etter hverandre, vises en pil med en teller.

Når du trykker på en piltast flere ganger på rad, vises det en pil i tastetrykkloggen;

denne piltasten har et nummer knyttet til seg som viser antallet ganger piltasten
ble trykket.

Dra og slippe et skjermbilde til en annen app
Du kan dra og slippe og sette inn enhver skjerm TI-Smartview™ emulator til MathPrint
™ kalkulatorer i et annet program.

TI-Smartview™ emulator til MathPrint™ kalkulatorerskjermer som du kan dra og sette
inn inkluderer følgende:

• Skjermen over tastaturet i emulatorpanelet

• Storskjermpanelet

• Lagrede eller ulagrede skjermbilder i skjermutklipp Workspace
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9 Bruke TI-SmartView™ Emulator Workspace tilMathPrint™ Kalkulatorer

Tilbakestille emulatoren
Slik tilbakestiller du emulatoren:

1. Klikk på Actions (Handlinger).

2. Klikk på Reset Emulator (Tilbakestill emulator).

3. Klikk på Reset (Tilbakestill).

Tilbakestille emulatoren:

• Overskriver den aktuelle emulatorstatusen

• Tøm tastetrykklogg



Lagre og laste en MathPrint™-emulator Status
Når du lagrer MathPrint ™ emulatortilstand, skapes en fil som lagrer
emulatorinnstillinger med alle endringene du har gjort.

For eksempel vil du kanskje sette opp en klassepresentasjon ved å legge inn data i en
data-editor og funksjoner i f(x) og g(x). Når du lagrer endringer i en emulatortilstandsfil,
kan du ganske enkelt laste inn filen når du vil holde presentasjonen. Hvis du vil lage
ulike presentasjoner for ulike klasser, kan du opprette flere emulatortilstandsfiler.

Merk: Tastetrykkloggen, skjermdumpene, emulatorvisningen og emulatorstørrelsen blir
ikke lagret i emulatortilstandsfilen. Vær oppmerksom på atMathPrint™ emulator
tilstandsfiler kan være store. Kontakt din IT-avdeling hvis du har problemer med
lagringskapasiteten.

Lagre MathPrint™-emulatortilstanden

Administrasjon, lagring og nedlasting av en emulatortilstandsfil er tilgjengelig for
alleMathPrint™ emulatorer. TI-30X Plus MathPrint™ emulatortilstandsfiler kan bare
lastes ned på TI-30X Plus MathPrint™ emulatoren.

Merk: TI-30X Pro MathPrint™ emulatoren kan bare lastes ned på TI-30X Pro MathPrint
™ emulatoren.

1. Klikk på Actions (Handlinger) > Save Emulator State (Lagre emulatortilstand)....

2. Gjør følgende i dialogboksen:

a) Finn frem til mappen hvor du vil lagre MathPrint™-emulatortilstandsfilen.
b) Skriv inn et filnavn. Bruk et navn som beskriver MathPrint™-emulatortilstanden.
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11 Bruke TI-SmartView™ Emulator Workspace tilMathPrint™ Kalkulatorer

Merk:MathPrint ™ emulatortilstandsfilen vil få et forhåndskonfigurert filnavn
med filtypen, * .s3l som indikerer at TI-30X Plus MathPrint™ Kalkulator
emulatortilstanden er opprettet av TI-Smartview™ MathPrint ™
emulatorprogramvare. Utvidelsen til TI-30X Pro MathPrint™ Kalkulatoren
emulatortilstanden er * .s3r. Utvidelsen til TI-30X Prio MathPrint™ Kalkulatoren
emulatortilstanden er *.s3i.

c) Klikk på Save (Lagre).

Laste inn en MathPrint™-emulatortilstand

Siden MathPrint™-emulatortilstandsfilene er spesifikke for hver kalkulatormodell, kan
du bare laste inn en emulatortilstandsfil for den aktive kalkulatormodellen.

1. Klikk på Actions (Handlinger) > Load Emulator State (Last emulatortilstand).

2. Gjør følgende i dialogboksen:

a) Finn frem til mappen der emulatortilstandsfilen er lagret.

Merk: Kun MathPrint™-emulatortilstandsfilene for den aktive
kalkulatormodellen vil bli vist.

b) Klikk på navnet på MathPrint™-emulatortilstanden for å utheve det.
c) Klikk på Open (Åpne).



Velge et visningsalternativ
Du kan tilpasse visningen for å vise eller skjule disse valgfrie panelene, og endre typen
informasjon som vises i hver av dem. TI-Smartview™ emulatorprogramvare
forMathPrint™ kalkulatorer viser som standard emulatorkalkulator Workspace i
storskjermpanelet.

Vise kalkulatorskjermen

1. Klikk for å
skjule storskjermpanelet.

2. Klikk igjen for å
Vise storskjermpanelet.

Velg en emulatortype

Klikk på nedpilen på for å lukke en emulatortype.

Hver emulatortype viser dens relevante kalkulatormodell.
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13 Bruke TI-SmartView™ Emulator Workspace tilMathPrint™ Kalkulatorer

Skifte kalkulatorens dekselplate

Slik endrer du dekselplaten:

1. Klikk på View (Vis).

2. Beveg markøren over Calculator Faceplate (Kalkulatorens dekselplate).

3. Klikk på et kalkulator-dekselplatenavn.

Lys Mørk Omriss

Vise eller skjule tastetrykkloggen

Klikk på for å vise eller skjule tastetrykkloggen.
Klikk på CLEAR (TØM) i panelet ved siden av tastetrykkloggen for å tømme loggen.

Klikk her og dra
for å endre
størrelsen på
tastetrykklogg-
panelet.

Klikk her når
du har valgt
taster for å
kopiere
skrifttype til
grafikk.

Klikk her for å
tømme
tastetrykkloggen.

Når du trykker på Clear (Tøm), vil du se denne informasjonsboksen:



Kopiere tastetrykkloggen til en annen app
Du kan kopiere hele eller en del av tastetrykkloggen til en annen applikasjon, for

eksempel et tekstbehandlingsprogram. Du kan kopiere tastegrafikken slik den
vises i tastetrykklogg-ruten, eller du kan kopiere tastetrykkene som tekst2U3.

Merk: Når du kopierer taster som skrifttegn, limer bare primære skrifttyper inn. Bare
primærtaster kan settes inn. Sekundær-taster kan ikke settes inn som skrifttype i TI-
Smartview™. Du kan manuelt sette inn andre funksjoner med den installerte
skrifttypen. Denne skrifttypen blir installert på datamaskinen din automatisk når du
installerer TI-Smartview™ til MathPrint™ kalkulatorer programvaren.

Kopiere taster som grafikk eller skrifttyper

1. Merk tasten(e) du vil kopiere.
For å velge taster i tastetrykklogg-ruten, bruk én av de følgende metodene:

Tast Metode

– En enkelttast: Klikk på en tast.

– Flere taster: Klikk på en tast.
Trykk og hold Ctrl (Kontroll) på
datamaskinens tastatur.
Klikk på andre taster for å velge flere
taster.

– Flere taster i sekvens: Klikk på en tast.
Trykk og hold Shift (Skift) på
datamaskinens tastatur.
Trykk på enda en tast.
Merk: Dette lar deg velge de to
tastene, pluss alle tastene imellom
dem.

– Alle taster: Klikk på en tast.
Høyreklikk.
Klikk på Select All (Velg alle).
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15 Bruke TI-SmartView™ Emulator Workspace tilMathPrint™ Kalkulatorer

Merk: Slik ser en tast ut like før og etter at du velger den.

Før: Etter:

2. Velg taster

3. Klikk på Edit> Copy (Redigere>Kopier) (for å kopiere taster som grafikk)

eller

Klikk på Edit>Copy As Font (Redigere>Kopier som tekst) (for å kopiere taster som
tekst)2U3.

4. Bytt til en annen app.

5. Lim inn tastene på aktuelt sted.

Merk:

• Du kan også dra de merkede tastene som grafikk til den andre appen.

• Du kan endre størrelsen på tastegrafikken etter at du limer dem inn i en ny app.

• I noen programmer kan tegnene som settes inn som skrifttype kun vises i en
skrifttype som fungerer i den applikasjonen, slik at de kanskje ikke ser ut som på de
vitenskapelige kalkulatortastene. Bruk om nødvendig den riktige skrifttypen for
kalkulatortasten på tegnene. Se i hjelpefilen for den målappen som du bruker for
flere detaljer om hvordan du skal bruke en skrifttype på tegnene.



Endre størrelsen på TI-SmartView™ Emulator storskjerm
Klikk og dra i kanten av et panel for å endre størrelsen på storskjermpanelet.

Merk: Alle disse er høyre/venstre-handlinger, unntatt tastetrykkloggen som trekkes
opp eller ned for a justere størrelsen.

Emulatorens og verktøylinjens posisjoner
Emulator-posisjon Venstre/Høyre – for å veksle mellom venstre- og
høyrehåndsvisning på den vitenskapelige kalkulatoren. Dette er
bekvemt ved projisering av en interaktiv tavle.

Verktøylinje - topp/bunn - for å bytte verktøylinjene mellom toppen og
bunnen av skjermen. Dette er bekvemt ved projisering av en interaktiv
tavle.
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17 Bruke TI-SmartView™ Emulator Workspace tilMathPrint™ Kalkulatorer

Alltid fremst
Velg dette alternativet i Vis-menyen til å holde TI-Smartview™ emulator til MathPrint ™
kalkulatorer vinduene åpne foran alle andre dataprogrammer. Akkurat som å ha
kalkulatoren liggende på pulten på toppen av papirene! Plasser vinduet på skrivebordet
hvor det best forblir Always in Front (Alltid fremst).

For å slå av Always in Front (Alltid fremst), opphev menyelementet i visningsmenyen.
Det finnes ikke noe verktøylinjeikon for denne funksjonen, og ingen indikator annet
enn menyhaken når aktiv.

Merk:

TI-Smartview™ emulator til MathPrint ™ kalkulatorer workspace-vindu og
skjermutklipp-vindu vil begge være "alltid foran" og veksler om hverandre avhengig av
posisjonen deres.

"Alltid foran" anbefales ikke når du er i fullskjerm-modus siden alle andre vinduer vil stå
bak fullskjermen på TI-Smartview™ emulator til MathPrint ™ kalkulatorer.



Bruke skjermdump
Du kan klippe ut dagens vitenskapelige kalkulatorskjermer ved å bruke TI-SmartView™
emulatoren til MathPrint™ kalkulator utklippsverktøyet.

Slik bruker du skjermdump:

▶ Klikk på verktøylinjen.

Dette vinduet vises:
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19 Bruke skjermdump

Deler av arbeidsområdet for skjermbilder

Ta skjermdump Klikk her for å ta skjermdump av et emulatorskjermbilde.
Actions (Handlinger) > Capture Screen (Ta skjermdump)
Merk: En ramme legges automatisk til hver skjermdump, men
du kan fjerne den ved å klikke på View (Vis) > Hide Screen
Capture Borders (Skjul skjermdumprammer). (Hvis du har flere
bilder, vil dette fjerne rammen fra hvert bilde).
Med skjermdump kan du:
• ta skjermdump av opptil 44 skjermer om gangen (hvis du

vil ta enda flere skjermdumper, må du slette bilder fra
vinduet Skjermdump).

• lagre skjermdumper automatisk i minnet til du lukker
hovedvinduet av TI-Smartview ™ til MathPrint ™
kalkulatorer.

Det vises en påminnelse om å lagre skjermdumpene når du
lukker skjermdumpfunksjonen. Du kan starte en ny
skjermdumpøkt under enTI-Smartview ™ til MathPrint ™
kalkulatorer

Save (Lagre) Klikk her for å lagre de valgte skjermdumpene.
File (Fil) > Save As (Lagre som)

Copy (Kopier) Klikk her for å lagre de valgte skjermdumpene til
utklippstavelen.
Edit (Rediger) > Copy (Kopier)

Delete (Slett) Klikk her for å slette de valgte skjermdumpene.
Edit (Rediger) > Delete (Slett)

Resize (Skalere) Skyv prikken langs linjen for å justere den aktuelle
forhåndsvisningsstørrelsen av skjermdumpen.
View (Vis) > Scale Screen Captures (Skalering av skjermdumper)
Merk: Skjermene lagres med prosentandelen i visningen.

Rename (Gi nytt
navn)

Gi skjermdumpen et nytt navn ved å markere tittelen og angi
et nytt navn.

View (Vis) Vis skjermdumper her.

Dra og slippe et skjermbilde til en annen app
Du kan dra og slippe og sette inn enhver skjerm TI-Smartview™ emulator til MathPrint
™ kalkulatorer i et annet program.

TI-Smartview™ emulator til MathPrint™ kalkulatorerskjermer som du kan dra og sette
inn inkluderer følgende:

• Skjermen over tastaturet i emulatorpanelet

• Storskjermpanelet

• Lagrede eller ulagrede skjermbilder i skjermutklipp Workspace



Tastaturoppsett
Du kan bruke datamaskinens tastatur til å trykke på en tast istedet for å trykke på den
tasten på TI-SmartView™-tastaturbildet.

Bruke datatastaturet
Hvis du vil trykke på en tast ved hjelp av datatastaturet, kan du bruke tabellen nedenfor
til å finne datatastaturtasten som tilsvarer emulatortasten.

• TI-30X Pro MathPrint™ or TI-30X Plus MathPrint™ hurtigtaster

• TI-30X Prio MathPrint™ hurtigtaster

• TI-30XS-30XB MultiView™ hurtigtaster

• TI-34 MultiView™ hurtigtaster
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21 Tastaturoppsett

TI-30X Pro MathPrint™ or TI-30X Plus MathPrint™

Eksempel: For å vise modusvinduet i emulatoren, trykk [W] på datatastaturet, som vist i
tabellen nedenfor.

TI-30X Pro MathPrint™ hurtigtaster:

TI-30X Plus MathPrint™ hurtigtaster:



*Merk:

På MAC-tastaturet,

- Trykk på [Delete] forJ.
- Trykk på [Backspace] for-.
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23 Tastaturoppsett

TI-30X Prio MathPrint™

Eksempel: For å vise modusvinduet i emulatoren, trykk [W] på datatastaturet, som vist i
tabellen nedenfor.

TI-30X Prio MathPrint™ hurtigtaster:



*Merk:

På MAC-tastaturet,

- Trykk på [Delete] forJ.
- Trykk på [Backspace] for-.
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25 Tastaturoppsett

TI-30XS/30XB MultiView™

Eksempel: For å vise modusvinduet i emulatoren, trykk [W] på datatastaturet, som vist i
tabellen nedenfor.

TI-30XS MultiView™ hurtigtaster:



*Merk:

På MAC-tastaturet,

- Trykk på [Delete] forJ.
- Trykk på [Backspace] for-.
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27 Tastaturoppsett

TI-34 MultiView™

Eksempel: For å vise modusvinduet i emulatoren, trykk [W] på datatastaturet, som vist i
tabellen nedenfor.

TI-34 MultiView™ hurtigtaster:



*Merk:

På MAC-tastaturet,

- Trykk på [Delete] forJ.
- Trykk på [Backspace] for-.
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29 Generell informasjon

Generell informasjon
Online-hjelp
education.ti.com/eguide

Velg ditt land for mer produktinformasjon.

Ta kontakt med TI-support
education.ti.com/ti-cares

Velg ditt land for tekniske og andre supportressurser.

Informasjon om tjenester og garantier
education.ti.com/warranty

Velg landet ditt for informasjon om lengden og vilkårene for garantien eller om
produkttjenester.

Begrenset garanti. Denne garantien påvirker ikke dine lovmessige rettigheter.

Texas Instruments Incorporated

12500 TI Blvd.

Dallas, TX 75243

https://education.ti.com/eguide
https://education.ti.com/ti-cares
https://education.ti.com/warranty
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